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17 9 [Eco033KVA U

18 10 Pro724700V U

18 10 :ho XP 600 60 W]

F | E D | Action L

() Eilter the list, in-place 1
@ Copy to another location 2
ist range: $B55:5F548 5 |
. . Criteria range = Sheet5!5D52:5053 | =
17 9 tEco03 3KVA | ' =l | s
18 10 Pro 724 700 V | [] Unique fecords only T
13 10 :ho XP 600 60 8
19 12 QT 600600\ | cancel | o
20 13 ical fiber KXXHetworkin| 1duad I 10
24 15 Pro724700V UPS 3 daad 11
24 17 Pro 724700V  UPS 2 el | 12
24 18 :ho XP 600 60 UPS 1 dpnd 13
24 138 55908 Switchdetworkin; 2 dua s 14
26 19 QT 600600\ UPS 2 dm 15
27 20 tEco03 3 KvA UPS 2 daal 16
27 24 A16 Optical mMetworkin) 1dands 17
30 24 LEco03 3 KVA UPS 1 auad 18
30 24 NiFi Cable Mdetworking 3 dandy 19
34 24 QT 600600\  UPS 3 s 20
34 26 535908 Switchdetworkin, 2l | 21
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Microsoft Excel >

| You can only copy filtered data to the active sheet.
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595,90k b adigy S 53 39290 slo 118 pleo] “
sloaigzsl o VBA Lungs aoly b SaS @y aidiS 55 15,5 LSy Htisbe aS e JuS! slodys plésl
I ol JuusSl a4y (55595,9L s a8LAl b a2l slodlw )3 Lol 592 503y Sl 63 didigs L) w2l b aS alike
@l 3ad dbo ol 53 @S Gl iy Ol slaigdl Eud H9w 9 SVL Ll iy Slhsil L g Solw a
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adigy ) pl> JusST 2B Sy g 3 L8 e JUS )5 g adigy Sy o 1) 5D Sl HUisle aS e ail )
345 skl AllData ob b gSie

3wl o 900

.S wlxwl |, Get Data>From File>From Folder aiy335 Data i ;1 g 3084 59530 (J8 3)lg Gusw

File Home Insert Draw Page Layout Formulas Data
[D'EFrom Text/C5V [&)Recent Sources El; A Queries & Conned
i
From Web = Existing Connections e
Get [% [tl ? Refresh
Data ~ EZ| From Table/Range All

annections

D From File > [E From Workbook

I:?:] From Database 7 I:E From Text/CSV G

Ij?= From Azure > E:B; From XML

EP

Iji. From Online Services > son] From JSON
ks

I:EL From Other Sources > Ij% From Folder

E@ Combine Queries b [E From SharePoint Folder

i F7 Launch Power Query Editor...

[.Dé. Data Source Settings...

Query Options

S Ol | 583 (sl (sol> augy Browse aisjS ¢35 b o 5L 62y 5o

Browse For Folder x

Folder

_ Desktop ~
@ OneDrive

a Mahmoud Baniasadi

3 This PC

1 Libraries

¥ Metwork

[EE] Control Panel Cance

&l Recycle Bin W

Folder path

- Browse...

agiS Cumbie 9 Miwe I sgSie adgy )3 39290 lohld Cuwd oxd L oy > Guaw
.3 |, Combine & Transform Data
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C:\Users\m.baniasadi\Desktop\MergeFiles

Content Name Extension Date accessed Date modified Date createc
Binary 2015Data xlsx | xlsx 19/4/2020 3:24:26 PM | 19/4/2020 3:24:26 PM | 19/4/2020 3:22
Binary 2016Data xlsx | xlsx 19/4/2020 3:27-:01 PM | 19/4/2020 3:27:01 PM | 19/4/2020 3:24
Binary 2017Dataxlsx | xlsx 19/4/2020 3:26-48 PM | 19/4/2020 3:26:48 PM | 19/4/2020 3:25
Binary AllData xlsx ®lsx 19/4/2020 3:30:34 PM | 19/4/2020 3:30:34 PM | 19/4/2020 3:27|
Binary ~SAllDataxlsk | xlsx 19/4/2020 3:32:11 PM | 19/4/2020 3:32:11 PM | 19/4/2020 3:32
O 0

Combine - Lload |~ Transform Data Cancel

Combine & Transform Data
Combine & Load
Combine & Load To...

ay aigal Olgic 4 |, 8 S Cuwbise Jol crand )5 aS o ol Combine Files oy al>je ¢l 51 G
25555 )18 plesl amg 5 b Jsdz b s 35 365 pasine 9 1S Er=e @i

Sheet ;> o L1 Lolai ;5 Lo sldodls aS ¢l @y azgi b g @13,5 il |, First File 4335 bo Jlio olgic a
23,5 il | aig3S ol Cuwl 39240

o X
Combine Files
Select the object to be extracted from each file. Learn more
Sample File: | First file -
P Sheetl M
Display Options ™ D} Date Sales Rep
P Parameterl [2] 3/6/2015 Adelina Oglesby I:I
B 2015Data 4/4/2015 Yulanda Mireles
5/10/2015 Timika Poe
[ Sheetl .
2/10/2015 Timika Fos
23/4/2015 Towanda Pemberton I:I
5/5/2015 | Earleen Milam
Skip files with errors Cancel

Sgu o 3L Query Editor )=y g 63,5 plésl po b |) adigy ¢l )3 39290 B Lolad JuuST 55 ¢l 51 G
2 659 ol Cuwl Sen b 3,05 51,5 Lo addigs 19,5 e AllData (16 3¢5 aS ¢l @y azgi b al>ye ¢pl 5o
hsd g g, (Source al>ye) oaui aidlw (5,505 aloye (ol @y Cawnbie bl abls L8 jeSke adbg

S s 1) gledgs> 5L 3590 sl L8
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(AP RETIETVE VR AT

| &%~ = | MergeFiles - Power Query Editor

Home Transform Add Column

V| (Select All)
v| 2015Dataxlsx
v| 2016Dataxlsx
v| 2017Dataxlsx
V| AllData.xlsx
V| ~§AlData.xlsx

Cancel

8 COLUMNS, 5 ROWS  Column profiling based on top 1000 rows

Begins With...

Does Not Begin With
Ends With...

Does Not End With...
Contains...

Does Mot Contain...

. m ol A o : Bi - -
é;j D [ie Properties (] 1 Al % Data Type: Binary ﬁ D [ Mew Source
Advanced Editor A [™ Use First Row as Headers + D:‘ Recent Sources =
Close &t Refresh Manage Reduce Split Group 1 Combine Manage Drata source -
Load~  Preview = [0] Manage = Columns* Rows ™ Column~ By 3 ReplaceValues - Parameters = settings
Close Query Sort Transform Parameters  Data Sources Mew Query
- ( £ .
S 3] Jx = Folder.Files w QUer‘)f Settlr'[]s e
4 Transform File from Mer... =
- E Content 44 ABC Name - ABC Extension -
4 Helper Queries [3] . 4 PROPERTIES
2| Sort Ascending sx
Parameterl (Sample F... - Name
) il Sort Descending Hlsx MergeFile:
El Sample File sx =
f‘( Transform File Xlsx All Properties
F Transform Sample File Xlsx 4 APPLIED STEPS
Remove Empty
4 Other Queries [1]
2 Text Filters b causls Source
E MergeFiles quals.. Filtered Hidden Files1
Search Does Mot Equal.. Invoke Custom Functionl

Renamed Columnsl
Removed Other Columnsl
Expanded Table Columnl

Changed Type

0

PREVIEW DOWMLOADED AT 3:39 PM

Filter Rows
Apply one or more filter conditions to the rows in this table.
® Basic Advanced

Keep rows where ‘Name'

does not cantain e 8 - AII[ -
® And Or
- 1% - || Enter or select a va M

*

Cancel

Ogiw e p.u|9),_.,o .AJ|G.J.9)§ 5,8 [oLf:.>| awg s )d JousS| sl Jold hssd (29N Oiobo a5 ¢l sl U0
xS ylg 1) .XISX diguu g eiss |, Equals g Text Filters aiy33 ¢ 65,5 ;U |, Extension

Filter Rows
Apply one or more filter conditions to the rows in this table.
® Basic Advanced

Keep rows where "Extension’

equals - | A8 || s -

® And QOr

- | |a% - || Enter or select o valu.. -

X

x5Sk =l sulgie Transform Sample File (5,595 il b 0,20y ¢l iz Caoww )3 (paixan
83,5 3o |, logyginn 51 L3 eleal 31 Ui aulgiey 3T Jlio plsie ay a5 90 ool 4y 3455 Bl elésl 51 Jad |

©

2216 Does Not Contain aiy;S ;35 b g aid, Text Filters Couwd @y @uilgi 0 Name ¢giuw ,ilid (53,556 b

.S Bi> 39290 (501> Cuwd I ) 3w All aalS (591> aS
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s Slegil a9 3@ plaul [ L, ol (5,565 ol 1> ol 0 3lgie S adlal (5,505 pgiw b
,S solgs
5l 3= 9 30,0 JuwS| bou=o @y Close & Load aiy;35 5l eslaiuwl b | 63 Jols azyis 3lgie gl )d Guizes
SIS b bl adls bo sl axdy b GluSy woz,lz )15 )13 b (il aubgy 19, oS LB Lo ol
A aolgs adlsl Refresh aig3S )35 9 eles Jod= (59 ol
Irol.é.ﬂ (_5[.04.&5.1
AU LSy Lo b ass ;3 13U oad plesl slocud aos oL o
il BB 5 Gugesl S 031051 @y iz 9 2l sy 18> b ol 50 55 39290 Jslaz cuglic o
10 Gl loggiw 64518 i) Lol bl
sloodl> 3929 W)gwo ;) ML abl 929 Slol Jodz j> 4 adlsl sloesls eauis plésl el ;> o
(ol 2,1 allio ol oz 1 aS 3)S Bl | abgy o (55luSh amg Canlio adlsl
o> a2 c\bg.u.o ).\J9.9 U.U)JT Cawl lo)\J J).SJ )|).9 L.S)il) (P (59) 03 lo'..c)l J.JLQ as GO ) e
(a2 (0 bl Uy, 95 |y S ol Ujsel aeldl )3)3g.8
i 4 U ulw g Woosls plésl JusST ol ssl> ;398 ST @S olés] sloaiSs cuawd ;5 aS gbe)los
b s slb> g0 ol )3 (o g gy pU s caibey ule Wio) by juass O LT b S Jiiitio 5,50
Do 0315 s Source al>yo 45 abgyye uydT Cuwl @3V g 3,5 Julgs cdl) >

Microsoft Excel x

| [DataSource.MotFound] File or Folder: We couldn't find the folder 'ChUsers\m.baniasaditDesktop\MergeFiles\*',

c\.wg.; Q o3 aslsl > (_;L@L»Lq dS.ul (5|).; C))gJo UJl PP cro:glo)l_) ).u.zj |) LeJJlQ (5919 d.uu9.1 rol.i Lo _x.uS UD)S
Cawl ‘o)y 9 sl .L.d)|9> U~> Refresh d..u)f uLzu| 9 (:’LGJ dg» 9 wb gSu.lS .>9.w bl PLC.)' PR G.loy).o
29 Bybyy bS] U @usiS Jae 05 J=>le Gob

.28 Wkl |, Data Source Settings uauw 9 Get Data aiy33 Data i

File Home Insert Draw Page Layout Formulas
F (B From Text/CSV [® Recent Sources ’7 B Queries §
|
@ From Web ) Existing Connections s Propey
Get L (B J Refresn LI Propeffe

Data ~ B From Table/Range

D From File >

[‘Tﬂ From Database >

All~

Oglesby

ws From Azure > lelina
am .
Mireles

landa

nika
[ From Power Bl dataset

nika Chevy 42681

wanda 15376

@ From Online Services 7 rleen Toyota 31568
dolf Honda 16375

[EL From Other Sources » wanda Jemberton Ford 22833
Mckee Ford 27394

{ Irish Ford 53739
{ g Combine Queries Goodson  Chewy 20479
{ Mckee Toyota 22571
{ @ Launch Power Query Editor... Maloney Chevy 49192
i [B Data Source Settings.. Eason Honda 29278
Poe Honda 22952

| Query Options Oglesby  Toyota 31254
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L 63,5 Iy U ki aS 33> adgy Browse 35 b Guaw 9 a3 |, Change Source aiy 38 oauib 5L 0,25 5
S Ol | e gose ol (535)b3 J=xo

X

Data source settings

Manage settings for the data sources used in queries.

# Data sources in current workbook Global permissions

Search data source settings El

c\users\m.baniasadi\desktop\mergefiles

X
Folder
Folder path
C\Users\m.baniasadi\Desktop\MergeFiles
Change Source.. Edit Permissions... Clear Permissions | ~
Close

Lazi a1 oyl sal> aibs Lo LB aS sl ol 315 a5 GASine Lol Cuwl &5 9 63l sy 2izs8 1S ol

203 el ) Oleghis ¢l U pad s ol ju | Olwdes ol Cunl 03V pudd 0 (5,500

|y Globo cunl @Y il Saolials o adbgs LuydT Gihlie o b euoss pll | al>so ol Hbyo eusles )]

Lead el ) 7

tmgd 0 b 25 &L o pleol b ol JIB slodolw Sl 6Su 5o
=LEFT(CELL("filename"),FIND("[",CELL("filename"))-2)

385 o lo 4y Spolils &g @y el ) 0T plésl 3uaB oS o Juld ylw o elésl Jlb aS (sladiisy LuysT &6 ol

S Flo>1)9 (5,595 0L 1> Source al>ye )5 1y GuydT ol CunsdlS o

S 5o (13U |y Jobw ¢l (LT Jokw o Jio ,3) s 3,90 Joluw 53 B8 Jsesd wiiuivs I puy LI ol sl

Reﬂ I =LEFT(CELL("filename"),FIND{"[",CELL{"filename"})-2)

K\L M N 0

1 | C:\Users\rp.baniasadi\Desktop\Merge Files

)23 53 9 aaijae |, From Table/Range aiy33 Data i jl ! Gl (b5 5)90 Johw aS il 5> Gugaw
.psiio |, Delete Until End aiy ;35 g 63,5 Cuwl, SWUS Promoted Headers al>;o (59, 635 3L
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GIwl 0 dg0x0 (6iumigi

| &2+ = | Ref- Power Query Editor

Transform Add Column View
-~ D:I Properties u o
Q -~ Bd
®7 T Advanced Editor A

Close & Refresh Manage Reduce
load~  Preview~ (5] Manage = Columns ~ Rows ~
Close Query

b3 Jo || = Table.

b - FE C:\Users\m.baniasadi\Desktop\Merge Files |~
= 123

@

s

Sort

2l (
b =
: split  Group

1
Column~= By

Transform

W

Query Settings

4 PROPERTIES
MName
Ref

All Properties

4 APPLIED STEPS

Source
Promoted Headers
X Changed Type

O

Data Type: Any ~
D Use First Row as Headers ~

‘37 Replace Values

Edit Settings

=] Rename
D EELE

><
9]
ez

Combir *

Delete Until End

Insert Step After

v Move Down
Extract Previous
1 COLUMMN, 0 ROWS  Column profiling based on top 1000 rows Pl EF:I Properties...

'o..u).m |) Drill Down c\.u).f 9 03)5 Cla.wb dAS G.bgg)-o L)""))T (59 UMW

fx = Excel.CurrentWorkbock(){

>

.E . 455 Columnl

8
Eg Copy
W Text Filters
1

33 FReplace Values...

1 C:\I lrarcimm hanizcadil I'\nrhnn\l.lh:r\na_ Files

[ Drill Dewn

Add as New Query

S o Dlg 1) 25 Jsesd ,b Vgeyd cuand 55 X ai3S 35 b s al>yo )

=Folder.Files(Column1)

[= Folder.Files{Columnl)

++| A% Name

2015Data.xlsx
2016Data.xlsx
2017Data.xlsx
AllData xlsx

~SAllData. xlsx

4 PROPERTIES
MName
Ref

All Properties

4 APPLIED STEPS

Source
Navigation
< Custornl

Query Settings

.S ol |, Formula Bar aig;3 View il awlgi o s Jled oy (5l ,U Ygo,d ,S1 1aiss

©)
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35S 3)lg 1) Ref ol abgyje Jooyd (sl 9 aid) Lghild plesl (5365 Jol alzpe ) CunsdlS a2y al=pe 5>

| @8- = | MergeFiles - Power Query Editor O X
“ Home Transform Add Column View 9
i u w8 ¥ . Bi -
é,;j D: Properties K :l 1h % Data Type: Binary ﬁ
DAd\ranced Editor i [™ Use First Row as Headers -
Close & Refresh Manage Reduce Split Group 1 Combine |*
Load~  Preview~ (] Manage ~ Columns = Rows ~ Column~ By =z ReplaceValues -
Clase Query Sort Transfarm
Queries [6] < fx = Ref hd i
- : / : Query Settings X
4 Transform File from Merg... -
. |[E] content +4| a8 Nam
] Helper Queries [3] 4 PROPERTIES
1 |[Binary 2015Data.xls
Parameterl (Sample Fi... . MName
2 | Binary 2016Data xlsx Y i
: ergefiles
E e 3 |Binary 2017Data.xlsx
fx Transform File 4 | Binary AllData.xlsx All Properties
F Transform Sample File 5 | Binary ~SAlIData.xlsx PPLIED STEFS
4 Oth, ies [2
er Queries [2] | source
FH MergeFiles Filtered Rows
FH Ref Filtered Rows1 a
Filtered Hidd...
8 COLUMNS, 5 ROWS  Column profiling based on top 1000 rows PREVIEW DOWMLOADED AT 8:03 PM

SleMbl (sol> aS i 9 Jusid 2,5 Query Editor 6,25 ;1 Home i > Close & Load aiy33 (535 b Lgl 5>

Awlos 0,053 | Juld g 63,5 Wi |, Comsd Ref (5,565 @ by o

SlS lgs Joaz 59, Milgioe 9 3l ol Sleahis gue @ 5L cadigy oo s b i )50 sy o2l

o Col esls U s |, Refresh aiy 38 g 65,5 cuwl,

(S G820 30> plil 3lgie (59850k aze 53 aS | (63,0, iS5 g 28,5 Mz padle> (e asbdl )

SAS T (59, pailgie pasine SLIS Syl eslaiuwl b pginw Mz 4 i Sy SuSa5 (sl (5595000 > )
03558 1az ,31 Lol S 3)lg |y 415 3,80 ,3SLIS 9 @uijs |, Split Column > By Delimiter... aiy 33 g 63,5 Cuwl,
23y el @33l b, ol (il asils iglise (slossiiSlaz Gi)le ay b bl woldio ways) 50,5 Lo
S Sl Ju8 alzgo 50 00l didigs @G )0 S90S Wi o)l 5L5 g Lo
(13 (65595,0L 3 1) 125 Joaz 3uiS U89

. 155 ColumnMame -

1 | Mahmoud&BanifAsadi

Excel SofwareTrain

.

L

Accounting,/Training

LS SuSaS LlS g/ g & 0aisSlaz L | oosly puslgs (50 399 JUo 5o
& Ebw @ G 9 paiS o Mg b (& Uie) osiiSIaz 51 Sy 9 63,5 Jas Jud U, Mile o ol 5>
S Jloel O (59, il U g0 03 aiibgs
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S 3lgie HLYge,0 Caound 5> aS bbise 12 gy Jol alzse 55 oaud aidigs gL
=Table.SplitColumn(Source,"ColumnName",Splitter.SplitTextByDelimiter("&",QuoteStyle
.Csv),{"ColumnName.1","ColumnName.2"})

ji = Table.SplitColumn{Source, "Columnblame"”, ~
Splitter.SplitTextByDelimiter("&",
Quotestyle.Csv), {"ColumnMame.l™, "Columnhlame.2"}

)
- ﬁ.,Bc Columniame.1 - ABC Columniame.2 -
1 | Mahmoud BaniAsadi
2 | Excel SofwareTrain null
3 | Accounting/Training null

{} colMe 215 "&" (sl 9 3uumgis | SplitTextByAnyDelimiter g, SplitTextByDelimiter (glow Guguw
S 3)lg |y 29> 45 5590 (sl,iSLS
1 2055 55 Gyg0 a7 @bl atdls (B g/ ,) 02uS1az aw aSigl oy3 b Olpms azais
=Table.SplitColumn(Source,"ColumnName",Splitter.SplitTextByAnyDelimiter({"&","/",","},
QuoteStyle.Csv),{"ColumnName.1","ColumnName.2"})

it = Table.Splitlolumn{Source, "Columnhame", e
Splitter.SplitTextByAnyDelimiter({"&","/",","},
Quotestyle.Csv), {"ColumnMame.l", "ColumnMame.z2"}

)
- ﬂ% ColumniMame.1 - M% ColumnMame.2 -
1 |Mahmoud BaniAsadi
2 | Excel SofwareTrain
3 | Accounting Training

aS 93> LS puoy plul aS (g9 ibusss aS ¢l 51 Ju8 Advanced Editor Cuawd ;5 (5,565,040 o -V
0 13 S CialS Sl 4y s g oS S 0ol 125 S S 9, W3S JS oS il ud ool puilgiie
A5 ol @y sS Juas she bol oS 0u35ale o) Lol losS pwlgiy (el 39291 diwlg>l s aS
(213 3,015 T 209k 9 FFO GadT )5 lojibio () 315 5929 izl Suibie
2L abs (3iz led Shgiws JS1 g 3550 9, Ctrl +/ jule 3,IS adls Cuwl bs ) i lah Oljgiaws S
a0 92 abgy e Wlilac S ool 330 ,LS5 b sy |, Alt+Shift+A
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Advanced Editor O x

Ta b ‘ e 1 Display Options e

1 /= let
2 Source = Excel.Currenthlorkbook(){[Name="Tablel"]}[Content],
3 #"5plit Column by Delimiter™ = Table.SplitColumn(Source, "Columnlame",

Splitter.5plitTextByAnyDelimiter({"&","/",","}, QuoteStyle.Csv),
{"Columniams.1", "ColumnName.2"})

4 in m

5 #"Split Column by Delimiter™ */

7 let

8 Source = Excel.Currenthlorkbook(){[Mame="Tzblel"]}[Content],

g #"Split Column by Delimiter™ = Table.SplitColumniSource, "Columnhams",
Splitter.SplitTextByanyDelimiter({"&","/",","}, QuoteStyle.Csv),
{"Columnkams.1", "ColumnMame.2"})

1@  1in

11 #"5plit Column by Delimiter”

+" Mo syntax errors have been detected.

Done Cance!

Geelire Ogie b Olhgiwd plojed b 36 5 pleie vley 43 (s> a8 (sl Advanced Editor cuawd ;-1

U..wo).d))lAwgpdw)b;))gpubdzo))gwb&bAlt.\.dSw;.;SlS)lSU.)l(_gl)J.))wal)
A 30lg> LS5 oad SIS (slo e dad 55 e b

Advanced Editor O *

Ta b|el Display Options ~ '9
ffthis is tes'tl m
/fthis is tes'tl —

ffthis is tes'tl I

[ T R NYR N

ffthis is tes'tl

ffthis is Eﬂiﬁ

woea

! Token Literal expected. Show error

Cancel

Jseso slogig, 32 35S SL |, b siz sulg>e (5,565,0L Advanced Editor hyxe ;> )31-€
s @SS 0,5 Wi ) sau kil bghs Ctrl+Shift+K oS 55 L ¢lgime (Delete g BackSpace a.ls)
Ol b o e 5l iewd hid (31 i b aolgs Bl o Ll bghs JS cdls ¢l 53 aS Cuwlsil

b oaub




r@@iranian.dr.excel
@ iranian.dr.excel@gmail.com

OIS 1 o Lwige i) Juazil €19
9 5195,9L ¢ JusS| sldoygd> wyde 9 Vlglal
S JuusS| 55 (paunigigSlo

dlis ol Yule> Jl> 0 89 e)lossel
AL Qi (I LW 0 Jisd A

b Ol 3 62 Al Gloyig, 9 9) Liny Alie
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Sub CommonValues()
Application.ScreenUpdating = False

Dim Dict1 As Object al)T b ustio SO L5 "Jgl " WleMbl 0,55 -
Set Dict1 = CreateObject("Scripting.Dictionary") (0,8 i)
For Each cell In [List1]

Dict1(CStr(cell)) = cell 'Dict(Key)=Item

Next
Dim Dict2 As Object Wl b pusio 5 53 "p9d Cawd" OleMbl 6,455 -
Set Dict2 = CreateObject("Scripting.Dictionary") G L)

For Each cell In [List2]
Dict2(CStr(cell)) = cell

Next

Sheet3.[A1].Activate

For Each cell In Dict1.keys

If Dict2.Exists(CStr(cell)) Then
ActiveCell.Offset(1).Activate
ActiveCell.Value = cell
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End If

Next cell

With Sheet3.[A1] alluo Zwly (59> sl okw (s30n,d > -
. Value = "Common Values" (GSuse i) 39450 03kl g g, (slaS |

. Interior.Color = rgbYellow

. Font.Bold = True

. Font.Size =16
.CurrentRegion.EntireColumn.AutoFit
.CurrentRegion.Borders.LineStyle = xIContinuous
.CurrentRegion.BorderAround Weight:=xIThick
End With

Application.ScreenUpdating = True

End Sub
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j @ Table
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Ll‘ ~) New worksheet
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15
16
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t Calibri ~ 11 ~ A" A7 &8 . o sy
- A% 0 = 5
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2 |100000IM. Jannesari Sy U4
3 |1000¢ & Cut e d
4 11000 53 Copy Jyate -
5 1000C (% Paste Options: 28 e A
3 e
6 1000C = J
7 | 1000C ; Jabas A
Paste Special... =
8 1000¢ el o5 ]
9 1000C g BEfI’ESh * -
10 1000C Insert » ¥ g
11 | 1000( Delete > L e
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T
13 | 10001 Clear Contents Shde s
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18 10001 - Insert Comment Conyert to Range
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19 | 10001 % Format Cells... ®r' External Data Properties... 4
20 10001 o . o Edit Que i
21 10001 ick From Drop-down List... E Vo R
22 10003 Q,J Hyperlink... 2] ? 3
23 100021 Zh. Shakoori Unlink from Data Source k)
24 100022 S. Rabieinezhadian Alternative Text... e
|25 1000223 H Haghchenaszadeh il

Connection i) Jgl Ciomud ;> aS 31> 3929 Caanud aww «uwl Edit OLE DB Query oU ay aS 6.3 b (590 50
Command Type 95 Cuawud ;5 9 30> @udles |y @il63,S 1,8, Jlasil S cuuls ay ol Gab 5l aS Lise g Gw)ydT
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Edit OLE DB Query ?lOx
Connection:
Provider =Microsoft. ACE.OLEDB. 12.0;User ID=Admin;Data Source=C:\Users -

\shamsololama.IRANLNG\Downloads\ L 558 GapliS\ w33 JlgaSwl U iopl3S =
Jlg.S ol .xlsm;Mode=5Share Deny Write;Extended Properties="HDR =YES;"; Jet -
OLEDB:System database="";Jet OLEDB:Registry Path="";Jet OLEDB:Engine Type=

35;Jet OLEDB:Database Locking Mode =0;Jet OLEDB:Global Partial Bulk Ops=2;Jet %

Command Type:

Table E]
Command Text:

Sheet1s

[ OK ] [ Cancel
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select * from [Sheet1$]
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sl Sy s ol a5 Lo Gunlins 1 ldosiaw plai iso 4y 6,buw * g
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Edit OLE DB Query [ 2 [

Connection:

Provider =Microsoft. ACE.OLEDB. 12.0;User ID=Admin;Data Source=C:\Users

\shamsololama.IRANLNG \Downloads\ U 58 syl 38\ S 3 JlgaSwl b sipliS
Jlg.L !l . xIsm;Mode=Share Deny Write;Extended Properties="HDR=YES;";Jet
OLEDB:System database="";Jet OLEDB:Registry Path="";Jet OLEDB:Engine Type=
35;Jet OLEDB:Database Locking Mode=0;Jet OLEDB:Global Partial Bulk Ops=2;Jet

Command Type:
SQL

Command Text:

select * from [Sheet18]

OK J[ Cancel ]

I

select ID,Name ,father_name from [Sheet1$]

Edit OLE DB Query L2 [

Connection:

Provider =Microsoft. ACE.OLEDB. 12.0;User ID=Admin;Data Source=C:\Users

\shamsololama.IRANLNG\Downloads\ b 5.8 a8\ wsST 3o Jleawl b gyl
Jlg.S ol .xIsm;Mode=Share Deny Write;Extended Properties="HDR =YES;"; Jet
OLEDB:System database="";Jet OLEDB:Registry Path="";Jet OLEDB:Engine Type=
35;Jet OLEDB:Database Locking Mode=0;Jet OLEDB:Global Partial Bulk Ops=2;Jet

Command Type:
SQL

Command Text:

' select ID,Name ,father_name from [Sheet1S]

-

=]

OK ][ Cancel ]
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(SQL) YlgsSawl.ausS 8saswl g, in)lsS ol 5o 9 aid)S Lo sy S awlei o 1) JloaSawl 63bw &ljgiuws
L Language Query Structured caéso SQL.Cuwl 6515 (5oL (5, Siws g Gawyiaw (sl 3,135t U SO

Al aidly el (592 9 Gux 0L

B350 [ 031 (lslol @y (5, Shws 9 uyiws o5l Loub 4y SQL o
Ll 500l o 3,135buw] auuwgo ANSI 5,l3stuwl S5 SQL o
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(SQL) gaxianzr by 1 o3liianl b JuuS1 1> 5SS |y

slalell yuads o] Asw 16\ @

DELETE (UPDATE (SELECT aiile (hol (slolosd 5l oS aimw LT aes ANSI b iidlgo sl (Jl> ¢l b
S Lo Lilyidy gelie g, 4 WHERE g INSERT.
tuanl 00T 125 2 a2 Jlio (sl 355 03Lail 03lwr 90 @) Blgie (5xSLHIS sl @S Gibgiws
ulizd SleMbl olod (ilgS1é o
SELECT * FROM table_name
select * from [Sheet1$]
A8 b b b pgiaw plgic yubwl 3 Gusliys OleMbl lg>)d o
SELECT column_name(s) FROM table_name

select ID,Name ,father_name from [Sheet1§]

210315 ;1,8 ;g5 (slgiil o aS by cyibld 5 55 b wald Gulwl ) OleMbl SlgSy6 o
Slo>1d 1) sl Veoolo ;I iS>gS ID aS ¢l @y a>g5 L father_name g Name g ID wleMbl Jlo ¢yl >
15,5 Jolgs>
SELECT column_name(s) FROM table_name WHERE column_name operator value

select ID,Name ,father_name from [Sheet1$] Where ID<100050

59 awsS asllho 1) ol Cawl Lo a8 o5 Jlio ¢l 5o O Liygel a5 JlgaSawl Olygiwd 38,5 1,8 Cap>
S O 68 GbS ) ol WL slaslys
SQL g VBA ;| oslisiuwl b JuwsSI 5 (5,8 inlsS -V
b0 L ol sl - eaiS uSy5 VBA aangs 35 b L eudls sl JlgaSowl bs b aS (53 GinlsS pusdlesn S|
g I Sy (5365 Wil g Table @b 5l o SWS Cuwly Jgaz (59, 0)L9d 9 35S 365, 1) 9,5k S
13S B8gio | 9)Slo a9 S Ll o5 jgiwd aibe |) JlgaSwl
select * from [Sheet1$]
Ol 5l Rdiowd aS 335 3l 35 ¢l @ aud (535 .3wS sxline | ol 35 9 63,5 5L | 95l G G
23 o LT g las Juld b 4y S
Sub Macro1()
Range("A2").Select
With Selection.ListObject.QueryTable
.Connection = Array( _
"OLEDB;Provider=Microsoft. ACE.OLEDB.12.0;User ID=Admin;Data
Source=C:\Users\shamsololama\Downloads\Filesgle" _
"Filesqle.xlsm;Mode=Share Deny Write;Extended Properties=""HDR=YES;"";Jet OLEDB:System
database=""";Jet OLEDB:Registry" _
" Path=""";Jet OLEDB:Engine Type=35;Jet OLEDB:Database Locking Mode=0;Jet OLEDB:Global
Partial Bulk Ops=2;Jet OLEDB:Global Bulk Tr" _

) -
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"ansactions=1;Jet OLEDB:New Database Password=""";Jet OLEDB:Create System
Database=False;Jet OLEDB:Encrypt Database=False;Jet OLED" _

) -

"B:Don't Copy Locale on Compact=False;Jet OLEDB:Compact Without Replica Repair=False;Jet
OLEDB:SFP=False;Jet OLEDB:Support Comple" _
, "x Data=False;Jet OLEDB:Bypass Userlnfo Validation=False")
.CommandType = xICmdSq|
.CommandText = Array("select * from [Sheet1§]")
.Refresh BackgroundQuery:=False
End WithEnd Sub
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.CommandText = Array("select * from [Sheet1§]")
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) Date Month
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£2) Bookl - Sheetl (Code) = R ==

(General) »  FillHumber -

Sub FillNumber () N

For i = 1 To 20
Sheetl.Cells(i, 1).Value = 1
Next i

End Sub
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Series I_|_J@ e
Series in Type Date unit
) Rows @ Linear i@ Day
@ Columns ) Growth Weekday
() Date Maonth
() AutaFill Year
|:| Trend
Step value: |2 Stop value: 2EI|
[ OK I\eJ ’ Cancel ]
L
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13 Status of the workbaok routing stip
GET.WORKBOOK ——

Returns information about a workbook

N, . o
Syntax % -4 myOnlineTraininghub
GET.WORKBOOKtype_num, name_text)
» The subject of the PowerTalk maler, a5 text
e 29 The enclosures of the PowerTalk mailer, as a horizontal
array of text
", . o 0 TRUE, f the Power Talk maler has been received from
> © | myOnIme Tra,nmghub another user (as opposed to just being added but not sent).
FALSE, f the maiier has not been received from ancther
- /7 " 2 & 1 = Routing in progress, or the workbook has been routed
-4 myOnlineTraininghub 108 e 3 The date and time the PowerTalk mailer was sent, 35 a
2 = Routing is inished serial number. Returns the #N/A error value If the maer
Typenum s 2 number that specifies what type of workbook information you want ke Aok yee ban sast
1 TRUE, f the workbook structure is protected; otherwise,
eyl 2 The sender name of the PowerTalk maler, as text. Returns
Type_num Returns the #N/A error value If the mailer has not yet been sent.
15 TRUE, If the workbook windows are protected; otherwise,
borp n The titie of the workbook as displayed on the Summary tab
1 The names of al sheets in the workbook, as a horizontal it hiomtoolomsynbeatat
array of text values. Names are returned as [book sheet
16 Name of the workbook as text. The workbook name does

34 The subject of the workbook as displayed on the Summary

not include the drive, directory o folder, or window number
tab of the Properties dialog box, as text

2 This will always return the #N/A error value.
17 TRUE if the workbook s read only; otherwise, FALSE. This is
e SQUEVIALE of GET.DOCUNENI(IN) s The author of the workbook as displayed on the Summary
3 The names of the currently selected sheets in the workbook, A0 ol ha IHTeition chatog box; ae et
as a horizontal array of text values. 18 TRUE if sheet Is write-reserved; otherwise, FALSE. This is
the equivelent of GET.DOCUNENT(3S) % The keywords for the workbook as displayed on the
Summary tab of the Properties dialog box, as text.
4 The number of sheets in the workbook 19 Name of the user with current write permission for the
woriiook: This I the eduvalént of GET.DOCUMENTIS) 7 The commants for the workbook as displayed on the
Summary tab of the Properties dialog box, as text.
B TRUE if the workbook has a routing slip; otherwise, FALSE 20 Number corresponding to the file type of the document as
) The name of the active sheet
isplayed in the Save As dialog box. This is the equivaient of
m
6 The names of allof the workbook routing recpients who OELNIUHENIE 2]
have not received the workbook, as a horizontal array of 2n TRUE if the Always Create Backup chack box is selected in Name text is the name of an open workbook. If name_text is omitted, it is assumed to be
boxt values. the Save Options dialog box; otherwise, FALSE. This is the the active workbook.
equivalent of GET.DOCUMENT(40) Example
7 The subject line for the current routing slip, as text. 2 e e S B L Vi Rk i The flloning macro formda returns the name o the acive shee n the workbock named
in the Calculation tab of the Options dialog box. This is the
8 The message text for the routing sip, as text equivalent of GET.DOCUMENT(43). WORKBOOK (36,
23 TRUE if the workbook has a PowerTalk maler; otherwise,
s If the workbook is to be routed to recipients one after FALSE. Returns #N/A if no OCE mailer i Raisted Pnciiena
another, returs 1. If it is to be routed all at once, returns 2 GET.DOCUMENT  Returns information about a workbook
2] TRUE if changes have been made to the workbook since the
At e et Aavacl FALLE I Cook e sichiaesaed (52 Wike) WORKBOOK.SELECT - Selects the specified documents in a workbook
10 TRUE, if the Return When Done check box in the Routing dlosed, will not promp to be saved;
Slip dialog box Is selected; otheswise, FALSE
25 The recipients on the To line of a PowerTalk mailer, as a
horizontal array of text
1 TRUE, if the current recipient has aready forwarded the 388
current workbook; otherwise, FALSE 2 The recipients on the Cc line of a PowerTalk mailer, as a
horizontal array of text.
12 TRUE, if the Track Status checkbox in the Routing Slip 27 The recipients on the Bec line of a PowerTalk mailer, as a
dialog box Is selected; otherwise, FALSE horizontal array of text
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I_fi Change options related to formula calculation, performance, and error handling.

Calculation options

Workbook Calculation@ [ Enable jterative calculation
® Automatic
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Automatic except for data tables
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Working with formulas
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File  Home Insert Pagelayout Formulas  Data  Review View  Developer Help  NitoProd  PowerPivot @ Tell mewhat youwa
SUM - X || =IF(E4=5,"Pay 10%","Pay 5%")
A B C D E F G H
1 | Array Formula IF Sample Data
2 i
3 Date Region Builder Units Average $k Total $k Method 1
4 B-Jan-08  Central Doug 8 389 3,112 :IF{E4>5,"Pay_10%","Pay 5%")
5 | 9-Feb-08 East Dave 10 385 3,850 Pay 10%
6 | 15-Mar-08 North Dave 3 771 2,313 Pay 5%
7 ] 18-Apr-08 South Brian 5 313 1,665 Pay 5%
8 | 5-May-08 West Larry 10 574 5,740 Pay 10%
9 | 22-May-08 Central Rob 8 730 5,840 Pay 10%
10 | 25-Jun-08 East Morgan 4 471 1,884 Pay 5%
11 | 15-Aug-08 North Jones 1 548 548 Pay 5%
12 | 12-Dec-08 South Doug 3 323 969 Pay 5%
13 | 10-Apr-08  West Dave 5 712 3,560 Pay 5%
14 | 14-May-09 Central Dave 9 432 3,888 Pay 10%
e sempie oo [ | VEGORUPBG G [ ipiEGen bR WP GOWE -

Aules JWis 1) 5 el B sl 03V 3w J= slanl)T g Jgosd S s |y aliuno oped ulesn ST >
Swles Okl ) 14:114 asb 1 ol o8

Fle  Home Inset Pagelayout  Formulss  Data  Review  View  Developer Help  NitroPro9  PowerPivot @ Tell me what youwantto
4 v fe
A B C D E F G H |
1 Array Formula IF Sample Data
2
3 Date Region Builder Units Average Sk Total Sk Method 1 m
4 6-Jan-08 Central Doug 8 389 3,112 Pay 10%
5 9-Feb-08 East Dave 10 385 3,850 Pay 10%
6 15-Mar-08 North Dave 3 771 2,313 Pay 5%
7 18-Apr-08  South Brian 5 313 1,565 Pay 5%
8 5-May-08 West Larry 10 574 5,740 Pay 10%
9 22-May-08 Central Raob 8 730 5,840 Pay 10%
10 25-Jun-08 East Morgan 4 471 1,884 Pay 5%
11 15-Aug-08 North Jones 1 548 548 Pay 5%
12 12-Dec-08 South Doug 3 323 969 Pay 5%
13 10-Apr-09  West Dave 5 712 3,560 Pay 5%
14 14-May-09 Central Dave 9 432 3,888 Pay 10%
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=IF(E4:E14>5,"Pay 10%","Pay 5%")

©

File ~ Home Inset Pagelayout Formulss Data  Review  View  Developer  Help  NitoPro9  PowerPivot @ Tell mewhatyouwa
SUM - X [ || =IF(E4:E14>5,"Pay 10%","Pay 5%")
A B C D E F G H |
1 Array Formula IF Sample Data
2
3 Date Region Builder Units Average Sk  Total $k Method 1 m
4 6-Jan-08  Central Doug 8 389 3,112 Pay 10% 5%") ’
5 9-Feb-08 East Dave 10 385 3,850 Pay 10%
6 15-Mar-08 North Dave & 771 2,313 Pay 5%
7 18-Apr-08  South Brian 5 313 1,565 Pay 5%
8 5-May-08 West Larry 10 574 5,740 Pay 10%
9 22-May-08 Central Rob 8 730 5,840 Pay 10%
10 25-Jun-08 East Morgan 4 471 1,884 Pay 5%
11 15-Aug-08 North Jones 1 548 548 Pay 5%
12 12-Dec-08 South Doug & 323 969 Pay 5%
13 10-Apr-09  West Dave 5 712 3,560 Pay 5%
14 14-May-09 Central Dave 9 432 3,888 Pay 10%
L e ons i NGOG VG I Ta IO - -

slodelw oloi )5 Wluwlxo azxyis ;o .3yl Ylojad Wygo ay |, Ctr+Shift+Enter glos s :pgw ,olf
(Method 2) ¢,y slgs elul 05 JSib @las T Gungidsesd huwss plojas &ygo a 14:114 4l
Adbie 038 3)lg Jood 0392 sl J5bles aS cuwl ai8)S 51,8 {} J515 5> oads 3)lg Joord b Jgaud o

File Home Insert Page Layout Formulas Data Review View Developer Help Nitro Pro 9 Power Pivot Q Tell me what you wa

1a - Ffe | {=IF(E4:E14>5,"Pay 10%","Pay 5%")}

A B C D E F G H I
1 Array Formula IF Sample Data
2
3 Date Region Builder Units Average Sk Total Sk Method 1
4 6-Jan-08  Central Doug 8 389 3,112 Pay 10% Pay 10%
5 9-Feb-08 East Dave 10 385 3,850 Pay 10% Pay 10%
6 15-Mar-08 North Dave 3 771 2,313 Pay 5% Pay 5%
7 18-Apr-08 South Brian 5 313 1,565 Pay 5% Pay 5%
8 5-May-08 West Larry 10 574 5,740 Pay 10% Pay 10%
£ 22-May-08 Central Reb 8 730 5,840 Pay 10% Pay 10%
10 25-Jun-08 East Morgan 4 471 1,884 Pay 5% Pay 5%
11 15-Aug-08 North Jones 1 548 548 Pay 5% Pay 5%
12 12-Dec-08 South Doug 3 323 969 Pay 5% Pay 5%
13 10-Apr-08  West Dave 5 712 3,560 Pay 5% Pay 5%
14 14-May-09 Central Dave 2] 432 3,888 Pay 10% Pay 10%
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File Home  Inset  Pagelayout  Formulas  Data  Review  View  Developer  Help  NiroPro9  PowerPivot ) Tell mewhat you wantto do
SUM - X « || =SUMIF(D:D,14,G:G)

A B C D E F G H | J L
1 Array Formula Sumif
2
3 Date Region Builder | Units Average $k| Total $k Builder Method 1
4 6-Jan-08  Central Doug 8 389 3,112 |Doug |=sUMIF(D:D,14,G:G)
5 9-Feb-08 East Dave 10 385 3,850 Dave 21917
6 15-Mar-08 North Dave 3 771 2,313 Brian 12253
7 18-Apr-08  South Brian 5 313 1,565 Larry 16198
8 5-May-08 West Larry 10 574 5,740 Rob 15509
9 22-May-08 Central Rob 8 730 5,840 Morgan 4212
10 25-Jun-08 East Morgan 4 471 1,884 Jones 2673
11 15-Aug-08 North Jones 1 548 548 Gill 7620
12 12-Dec-08 South Doug 3 323 969
13 10-Apr-08  West Dave 5 712 3,560
14 14-May-09 Central Dave <] 432 3,888
15 10-Sep-09 East Brian 5] 460 2,760
16 31-Oct-09  North Larry 3 741 2,223
17 18-Sep-08 South Rob 8 580 4,640
18 25-Nov-08 West Doug 6 685 4110
19 29-Dec-08 Central Dave 2 401 802

. FoplOma G WOOWMGaaMewh  MlsionTdbe  Mitplcain Colmes
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File Home  Inset  Pagelayout  Formulas  Data  Review  View  Developer Help  NitroPro9  PowerPivet  Q  Tell mewhat youwant to do
K4 ~ I

A B C D E B G H I J K
1 Array Formula Sumif
2
3 Date Region Builder Units Average Sk Total Sk Builder Method 1
4 6-Jan-08 Central Doug 8 389 3,112 Doug 8830
5 9-Febh-08 East Dave 10 385 3,850 Dave 21917
6 15-Mar-08 North Dave 3 771 2,313 Brian 12253
7 18-Apr-08  South Brian 5 313 1,565 Larry 16198
8 5-May-08 West Larry 10 574 5,740 Rob 15509
9 22-May-08 Central Rob 8 730 5,840 Morgan 4212
10 25-Jun-08 East Meorgan 4 471 1,884 Jones 2673
11 15-Aug-08 North Jones 1 548 548 Gill 7620
12 12-Dec-08 South Doug 3 323 969
13 10-Apr-08  West Dave 5 712 3,560
14 14-May-09 Central Dave 9 432 3,888
15 10-Sep-09 East Brian 6 460 2,760
16 31-Oct-08 North Larry 3 741 2,223
17 18-Sep-08 South Rob 8 580 4,640
18 25-Nov-08 West Doug 5] 685 4110
19 29-Dec-08 Central Dave 2 401 802
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=SUMIF(D:D,14:111,G:G)

Fle  Home Insert  Pagelayout  Formulss  Data  Review  View Developer  Help  NitroPro9  PowerPivot @ Tell mewhat you want to do
SUM - X « J | =SUMIF(D:D,14:111,G:G)
A B C D E F G H | J K
1 Array Formula Sumif
2
3 Date Region Builder | Units Average Sk | Total Sk Builder Method 1
4 6-Jan-08 Central Doug 8 389 3,112 Doug 8830(G)
5 9-Feb-08 East Dave 10 385 3,850 Dave 21917
6 15-Mar-08 North Dave 3 771 2,313 Brian 12253
7 18-Apr-08  South Brian 5 313 1,565 Larry 16198
8 5-May-08 West Larry 10 574 5,740 Rob 15509
£ 22-May-08 Central Reob 8 730 5,840 Morgan 4212
10 25-Jun-08 East Morgan 4 471 1,884 Jones 2673
11 15-Aug-08 North Jones 1 548 548 Gill 7620
12 12-Dec-08 South Doug 3 323 969
13 10-Apr-09  West Dave 5 712 3,560
14 14-May-08 Central Dave 9 432 3,888
15 10-Sep-09 East Brian <] 480 2,760
16 31-Oct-09  North Larry 3 741 2,223
17 18-Sep-08 South Rob 8 580 4,640
18 25-Nov-08 West Doug <] 685 4,110
19 29-Dec-08 Central Dave 2 401 802
| snpltes s vioomGedvess Wbl Mgl colms

slodolw oloi ;> Wluwlxo azyi )5 o) liey ylojed Wygo @ |) Ctri+Shift+Enter (slos, S g ‘olf
.(Method2) 8,3, aslgs ploul yuj JSib @ilbe slahl GuneiJsesd bawgi (lojed jgw ay K4:KTT azb
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File Home  Insert  Pagelayout  Formulas  Data  Review  View  Developer Help  NiroPro9  PowerPivot ) Tell me what you wantto do

K4 - fe || {=SUMIF({D:D,I14:11LG:G)}

A B C D E F G H | J K
1 Array Formula Sumif
2
3 Date Region Builder Units Average Sk Total Sk Builder Method 1
4 6-Jan-08  Central Doug 8 389 3,112 Doug 8830 8830
5 9-Feb-08 East Dave 10 385 3,850 Dave 21917 21917
6 15-Mar-08 North Dave 3 771 2,313 Brian 12253 12253
7 18-Apr-08 South Brian 5 313 1,565 Larry 16198 16198
8 5-May-08 West Larry 10 574 5,740 Rob 15509 15509
8 22-May-08 Central Rob 8 730 5,840 Morgan 4212 4212
10 25-Jun-08 East Morgan 4 471 1,884 Jones 2673 2673
11 15-Aug-08 North Jones 1 548 548 Gill 7620 7620
12 12-Dec-08 South Doug 3 323 9269 E
13 10-Apr-09  West Dave 5 712 3,560
14 14-May-09 Central Dave 9 432 3,888
15 10-Sep-09 East Brian 6 480 2,760
16 31-Oct-09  North Larry 3 741 2,223
17 18-Sep-08 South Rob 8 580 4,640
18 25-Nov-08 West Doug 6 685 4110
19 29-Dec-08 Central Dave 2 401 802
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9 | Lijdesas sl _ 70 80 90 100 110 450

INDEX 23U sloculls-V

U 50> 2929 alizo 3)lgo (Jg dgi 50 olaiwl (sdaxi0 (sl Js0y8 g lduSyi I loosls gliwl gl JusSl )
1S oolaswl INDEX g 51 0,18
0315 ya0l N (53,91 Cawwdy -1-W

23S oolaiwl 5 Jgesd 5l Gl LIS 6315 ¢yaeIN ¢)3,91 Cway (sl

=INDEX(G3:G9,3)
A | B C D E | F , G | H , I )

1 Personnel of sales company

F-Name L-Name

dizs, diyda 9357654806 10 20 30 a0 50 150
4 AT Glas 5188328393 20 30 40 50 60 200
5 a9 (Bag 8387068631 30 40 50 60 70 250
6| | (gug0 AT 9134093909 a0 50 70 30 300
7 LNINY-) Sdyal 5130371150 B0 60 70 20 30 380
8 g Qlaple 9371277490 60 an 90 100 400
9 | Lojdema oralze 9138184776 70 30 90 100 110 450
10
11

Oraga g3 )lude

R 60 =INDEX(G3:G9,3)

12 sep ol 3l 44
13

1Wo




INDEX g, il |

=olx0 Ld) dazo (03uug @

Vgiw g yuw LOW Joeo 391 Cauwdy -P-W
oelM g s, uelN )3 aS slosls ay puslezy aS ijeo )5 b g pgiw g s AW Jxo 36T Cawsy sl
1auwS eolaiwl dgo)s 51 G Cuwl U_le {Q.\JS |.hu Cuwd 31> )|)9 9w

=INDEX(63932x0,N,M)
=INDEX(A3:19,6,3)
A [ B C D , E , F , G [ H [ 1 1]
1 O Loty Personnel of sales company

2
3| iz diye 9357654806 10 20 30 40 50 150
a4 AP Glasji 9188328393 20 30 40 50 60 200
5 39 gl 9387068631 a0 40 50 60 70 250
6 s [CATED 9134093909 | 2% C-“‘:“:‘_ 50 60 70 80 300
7| cglan el 9130371150 ﬂ 60 70 80 90 380
8 gy glaals - 9371277490 ~ 60 70 80 90 100 400
9 | Lajdeme rala { 9138184776 70 80 90 100 110 450

Ogiw g sLoosls JS zlydxiwl -P-W
olital 415 ooy Sl camsl GAIS UG olo gy (Sile Jlio lsic @ i S sloosls JS gl (sl

=AVERAGE(INDEX(F3:F9,,))

A B £ D E F G H I |1

Personnel of sales company

1
) F-Name L-Name

3| dizg digda 9357654806 10 20 30 a0 50 150
4| e Glasgi 9188328393 20 30 a0 50 60 200
5 | 3992 Sad 9387068631 30 a0 50 &0 70 250
6 §o3a AR 9134093909 40 50 60 70 20 300
7| o (S dyal 9130371150 30 60 70 80 30 380
8| e Glaale 9371277490 60 70 80 30 100 400
9 | Loptama salmea 9138184776 70 30 30 100 110 450

12| aug el Sig,d (nSilue 60 =AVERAGE(INDEX(F3:F9,,))

[ 33 )53 Ulgie AR Ugiw 390 5 Uaied (xS 3Ll o b JI gl 5l ) sl ) Vlgie taiSs ]
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=olx0 Lo) Jazxo (03uug @

=SUM(INDEX(A3:19,,9))

A | B c D E F G H I

1 Personnel of sales company

Py F-Name L-Name

3| diggy aipde 9357654806 10 20 30 40 50 150
4 Giga dl.n:r).v 9188328393 20 30 40 50 60 200
5 95 Sag 9387068631 30 a0 50 60 70 250
6 Sge Gl 9134093909 40 50 60 70 80 300
7| com Sl 9130371150 80 50 70 80 90 380
8 jryeT Glapls 9371277490 60 70 80 90 100 400
9 | Laydama = 9138184776 70 80 90 100 110 450
10

ey
s

Shesd S aax 2130 =SUM(INDEX(A3:19,,9))

ary
=]

e a4y 9w -F-1
Sy Lol 3,5 1) e a4y g Sl Jg uwl VLOOKUP g3l (355 bl Cawgd 9 3,05 golgs 5l oSu
1S B> 5 Jlio @ .S 0 el |y olSel ¢l MATCH g INDEX &)U
=INDEX(B3:B9,MATCH(A12,C3:C9,0))

A [ B | C D | E | F | G | H | 1 8]
Personnel of sales company

(=

2
3| wips Lo 9357654806 10 20 30 a0 50 150
4| s e 9188328393 20 20 a0 50 60 200
s (s s 9387068631 30 0 50 60 70 250
Bl o0 [ e 9134093909 40 50 60 70 80 300
7| cyn Sl 9130371150 80 60 70 80 %0 380
8 e S 9371277490 60 70 80 ) 100 400
9

9138184776

12] 9138184776

A B | C D E | F | G | H | 1 |y

1 Personnel of sales company

2 L-Name

3 Al zgy Ayl 9357654806 10 20 30 40 50 150

4 i g Glasy 9188328393 20 30 40 50 60 200

5 i BITPY fr-ret 9387068631 30 40 50 60 70 250

6 | [Tl S 9134093909 40 50 60 70 B0 300

7 i Sl 15 daal 9130371150 B0 60 70 B0 S0 380

8 i o shaple 9371277450 60 70 B0 90 100 400

9 i Loylaxa Eraloea 9138184776 70 B0 S0 100 110 450

Wy




INDEX g, il |

=olx0 Ld) dazo (03uug @
’\Lols L’_'J)Q.-ag 9 .))...Su.o)b.}).) |) 0593=>0 dgl J)90 W hag dgo)_‘) L:J9 0D uLzul d.nls 0593 >0 dS.ul D Q>9J LJ

A0 )5 ) Clgz Suelils

A3 3)90 Jolaz as g2yl -5-1
=SUM(INDEX((H3:H9,D3:D9,F3:F9),,1))

A B c D , E , F , G , H , 1 [1
Personnel of sales company

=

2
3| digsy dida 9357654806 10 20 30 40 50 150
4| s Glas 9188328393 20 30 a0 50 60 200
= s 9387068631 30 a0 50 60 70 250
6| o S 9134093909 a0 50 60 70 30 300
7| coun Sl 9130371150 30 60 70 80 90 380
8| e Glanle 9371277430 80 70 80 90 100 400
9| Lapre gl 9138184776 70 80 90 100 110 as0
Jgayd 2 ¥ 2l [ Jyard 2 T el ] [ Jgard )3 ) el ]

2| 4ol a>gbans 560 =SUM(INDEX((H3:H9,D3:D9,F3:F9),,,1))

13

5505 @ilg5 U INDEX gl wusSyi -V-W
Dgah Sy 5300 gilei b aS caade plis |) 395 (=Bse @ ool jlxel
ROW (COLUMN (INDEX gilgi <SS @y Jga> i (93,5 wgSzo -1-V-¥

=INDEX($B$3:$J$9,ROW(B3)-2,9-COLUMN(B3)+2)

A B C D E | F | G [ H | 1 | J K
1 Personnel of sales company
2 L-Name
3 | PUFSY: diyia 9357654806 10 20 30 40 50 150
a| g ey 9188328393 20 30 40 50 60 200
5 | e Loy 9387068631 30 40 a0 60 70 250
6 | Tl AT 9134093909 A0 50 60 70 B0 300
7 | bl Gl 9130371150 80 60 70 80 90 380
8 | o Lﬂ_l&‘ﬂ;}’& 9371277490 60 70 B0 90 100 400
9 | Ly damea ealoen 9138184776 70 80 90 100 110 450 |
10_ .
11_
12| =|NDEX($B$3:$J$9;ROW(B3)-2;9-COLUMN(B3)+2)
13
14|
15_ ' 150 50 40 30 20 10 9357654806 digda all T
15_ 200 60 50 40 30 20 5188328393 L},Ln__. 3 15dga
1}'_ 250 70 60 50 40 30 9387068631 -rel 9
18_ 300 B0 70 60 30 40 9134093909 [CAVE I 5gR
1‘3_ 380 90 B0 70 60 B0 9130371150 A ol iy
20_ A00 100 90 80 70 60 9371277450 Lgll.ém!.r- Jase
21- 450 110 100 90 B0 70 9138184776 ralxa Loy laoca j
22




INDEX gU jlxel !Q_

=olx0 Lo) Jazxo (03uug @

S5 390 (g9xium> agz> MATCH g SUMPRODUCT (INDEX gilgs «asSys -V-V-I
=INDEX(I3:19,SUMPRODUCT(MATCH(1,(B3:B9=B13)*(A3:A9=A13),0)))

A B C D E F G H I J

1 Personnel of sales company
2 F-Name L-Name

O
3 all fe7) dizda 9357654806 10 20 30 40 50 150
4 Blga LgLnJJJ 9188328393 20 30 40 50 60 200
5 95 Bagd 9387068631 30 40 50 60 70 250
6 g AT 9134093909 40 50 60 70 30 300
7 Gl 15dual 9130371150 80 60 70 80 90 380
8 o Glaple 9371277430 60 70 80 90 100 400
9 | Laplesea e 9138184776 70 80 90 100 110 450 |
10
11 80 3y54 aiv> Cgx index , sumproduct , match alg LuSy

[ ] [ ]
13 colad | casl | 380 =INDEX(13:1S,SUMPRODUCT(MATCH(1,(B3:89=B13)*{A3:A9=A13),0]))

‘quby

ASe o OR olse (+) o9y jSloc 9 AND Joloo (*) wis Sleac slanl)T slodgayd ) @

9le Sl 1) (g 5o ) by Olin b biiiigs aS (nl2) | s3e ilSe Cusdse (MATCH 2 L e

sy |y 338 s Capmdge hid o ay,sSai b5 55 g WBis |, #NA (slalhs SUMPRODUCT g L e

2910
9] (0w ) aawd CusBgo ,lake INDEX g6 b culgi 5 g
INDEX ¢ ROW (SMALL ((IFERROR (IF gilgi Sy -V-V-V

105 @ises ilho 58 glsi a1 (B oginw) o b ,blite Sisy slsel s (A oinw) Grade oSy (symian> ug
(5,5 o3liiuul Ctri+Shift+Enter slosals 51 il sl @ 34l 5 038 (slaulyT Coyumy Jsard ) -eaiSie 05liiul

A B [C| D E F G
1 mm |, Grade | Number Formula
2(a | 32 I a | 32 {=IFERROR(INDEX($AS1:5B$15, SMALL{IF(3A$1:3A815=8D$2, ROW(SAS1:3A515),""),ROW(A1)),2),"")}
3| b 99 174 {=IFERROR({INDEX($SAS1:5B515, SMALL{IF($AS1:5A515=5D52, ROW[SAS1:5A515),""),ROW(A2)},2),"")}
4| b 57 624 {=IFERROR(INDEX($AS1:5B$15, SMALL{IF(3A$1:3A815=8D$2, ROW(SAS1:3A515),""),ROW(A3)),2),"")}
5| ¢ 100 599 {=IFERROR(INDEX($SAS1:5B515, SMALL{IF($AS1:5A515=5D52, ROW[SAS1:5A515),""),ROW(A4)},2),"")}
6| d 65
7| ¢ 24
8| a 174
9| b 249
10 b 324
1| ¢ 399
12| d 474
13| ¢ 549
14| a 624
15| a 599
16

“pwogl

Lol Lolad @y 545 Lo g 3313,5ax 5215 @ 1) sl sl lgis INDEX o MATCH gylsi Sy aS (el 5l @
S S5 o b 1) IF 5 (LARGE) SMALL g6 95 3l gl

s CapzBge ROW g1 b g @S o lay s b5 390 lade Jolis a5 |, Lylo sl IF gl b Ixl )5
xS e 50 38l () epiisS > b FALSE 3l sl 5 purlaiire (sl 3Sailis | guwly Jobuw

oLl (5)1380)lods Sy «S)50 @ S26S 5l i @ «ole> s9l> Jolw 12 (sl ROW g SMALL gl Lo
280

.).Jl.))fu.o).) ).g)ls P |) 0 G)lifﬁhm (5L®d91.w ) k.,ug_‘ign (NDEX EJLJ uJLeJ Dge

we



INDEX g, il |

=olx0 Ld) dazo (03uug @

(aliold) SPACE SIS ;1 osliial b ¢ygiaw 9 sl 8 Joxo -F-V-F
=INDEX(C3:19,MATCH(A12,B3:B9,0),) INDEX(C3:19, MATCH(B12,C2:12,0))

| A | B C D | E F G | H I
1 > Personnel of sales company :
5 TEL jun jul aug sep oct total
3| algsy | 4w | 937406 0 20 3 a0 s 10|
44\ s | Gy | 9188328393 20 30 40 50 60 200
5| 3sn | es | 9287068631 30 40 50 60 70 250
64" EH | S 9134093909 40 50 60 70 80 300
7< coe | s 9130371150 80 60 70 20 90 380
Si e | Qleals 9371277450 60 70 80 90 100 400
9 Lﬂ)m @31::»_ 70 80 90 100 110 450
10/
11 Jte Axsis
12/ oy TEL |9138184776 | =INDEX(C3:19,MATCH(A12,B3:B9,0),) INDEX(C3:19, MATCH(B12,C2:12,0))

esiogs
28 @y asl 95 BW Jxo SPACE LsSLS ez ¢yl laahl GuSys sloadds ay Lo gy ol o
.).Jb)gu.o).;
slabT Cygas @o b ggiw 93 wuSyi 9 & ;Slac jl 63liuwl b ydlie Zl)Siuwl g gaxians -0-V-F
{=INDEX(C3:C9,MATCH("lib, 0m0"&" L >gloxo", A3:A9&B3:B9,0))}

A B C D | E | F | G | H [ 1 [1]
Personnel of sales company

1

2 F-Mame L-Name

3 4| fe ) 4iglda 9357654806 10 20 30 40 S0 150
4 [CAET Slesyd 9188328393 20 30 40 50 60 200
5 3092 oy 9387068631 30 40 50 60 70 250
6 53R AT 9134093509 40 50 60 70 80 300
7 Calddy Sdal 9130371150 80 60 70 80 90 380
8 Joser Qbapls 9371277490 60 70 80 90 100 400
9 | Lojlaxa T 9138184776 70 30 90 100 110 450

12| Jga,d Bub olsad ojleds | 9138184776 | {=INDEX(C3:CO,MATCH(" 2sls"&"Ls)ylaxxs",A3:A0RB3:B9,0))}

oy
1S i 2l b 2gabe eslaiuwl By wasS)i sl gz sl Ubg) onl o>
owbwly 5w o 4ol sl 9 90 Sy & b Solgils b g pb (MATCH gl Jol ¢)logS,T )o@
@il (5)lx0 (;S6S Ugiaw Sy SuST ol b - B9ab0 wuS)5 & b >l 93 330 (MATCH g0l Jl ologS)T
Dguie 0315 Sy )5 @) gz 390 rw Cu=Bge INDEX U b colgs 53 g dgdi0
(.3, osliiuul Ctrl+Shift+Enter (sloas 51 il sl au U g 6392 (slaulT <ygm Jgoyd col)
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VLOOKUP 2/t [

VLOOKUP gl 9,20 -

(83908 Sexim> e ay Vertical Look Up Caéso «JunS| galgi (32,089 ,20 5| S vlgic o VLOOKUP &,ls
&U ol 9o esldiwl SileMbl SOL b Joaz So 09)d 295, S aaiie 93,5 iy sohie 4y aS Abbe

1 525 b a2 53909 Ll
ok LT b sh5ne Gl a)leds (Jle (sl ¢ T JW @ oS cuwl ik il Look Up Value -)
g0 Hlg Caound l 53 d9: b O 45 Gl 0)lasd Sl 1,8 aS
20U 639320 .38: 0 3o Cuwl 63 s T Jd Gliawyy WleMbl aS (glosgaxo (59,9 (1l > :Table Array -¥
9 3l (g 35 Jbo (slw) puiams o JWis oS Li)le Jolds o wgiw ool aS 594 3)lg (slassSay
9 @Sl 2ox5 pleic @ T SleMbl puly e oS 2L Gigiw Jolib (prizzad
gz OleMbl 639320 9 Jol (539,59 13 s T JLs @y azsl 3,5 jasivwe | A=y :Col Index Num -
Olgic @y WleMbl 63930 I Ygiw Gaodiz as bgyye 031 S e aRiie Pgw (5399 13 091 (5919 1>
g 0305 Giules =95
9 (Exact Match) False <l 95 hls> a5 53,5 0 Lot gxbuu> £95 (5399 ¢l > ‘Range Lookup -&
Dgdbe osleiwl Exact Match s I g8lge el 5> aS cuwl (Approximate Match) True
3o lal a5 xibbie Sgo ol @ aswis =VLOOKUP(14,C3:F12,2,FALSE) Jgo,d 1 65l g , 13
Ui 394050 92 9 > (F3 U C3 63910 jl (ygsaw (padgl) C12 U C3 639320 (99,0 14 Jokuw (99,5 62 il
Daie 0315 Ginled 29,5 olsie @ D gginw 45 Jokw o ol oai b lado
Abbie 030l B 425 Joaz > lixe slodseyd jl Juol> aziis (398 Wlxudgi b

H G F D C B A
1
- 2
1,v4, AL & 3R dacee \-¥F \ 3
|| (87 || uxw,.;.a.r" IRZE S (Jauy sl (844 Y 4
¥,.8% e Sl dilgady (514 \ 3
30 \f 454 Jree il digs 1YY ¥ 4
oo Bl =VLOOKUP(I4.C3:F12.2.FALSE) Pl Ao waayly s g {04 & 7
doayls =VLOOKUP(I4,C3F12,3 FALSE) o AN, wioyls o pBLS 1-YA # 8
07,00 =VLOOKUP(I4.C3:F12.4FALSE) e FARY, .o e FEANT S S388l peee 141+ Y 9
LARL RS e YRS 1-1¥ A 10
1,FFD ens iy IS S daeaw 11y q 1
F¥Ae aas e lgady oo 1Ty Ve 12
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S Lot
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RSP
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VLOOKUP gL ;| 6sldtiuwl b Oldlo auwlxe Cagz SaS Jga> -Y

13905 aaln |y 093 iz Sllle (C2 sk ) 525 Jsard 3l 3Ll b lgie al>ye cyl 5

=VLOOKUP(B2,G2:H6,2, TRUE)*B2

@lho |) T pg> (53959 2L camlas Jlacl 55 s slodslw ln 1) @388 Jsosd pudlg> 0 aSOT 4y azgi
3giie ol 113 0 &) 5 s Jsasd 13 io9e3

=VLOOKUP(B2,5G$2:$HS$6,2, TRUE)*B2
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VLOOKUP &5

(§3aio Juol [05uug @

H G F E D < B A

wldb ol yo Jso ol el el |

<. . =VLOOKUP(B2.8G$2:$H$6.2, TRUE)*B2 Wesfen VT gl b |

Vel Vorwoyeee =VLOOKUP(B3.$G$2:5H$6.2. TRUE)*B3 VIFGF FAR s e sl | g

Y Toooe,one =VLOOKUP(B4,8G$2:$H$6.2, TRUE)*B4 WY TV el sy

v Foovayees =VLOOKUP(B5.$G$2:SH$6.2, TRUE)*B5 TARLT - VO alsyain | g

g1 fyeveyeee =VLOOKUP(B6,5G$2:$H$6.2, TRUE)*B6 VARBY e A e Rl |

=VLOOKUP(B7.8G$2:$H$6.2, TRUE)*B7 VRO PR R B |

=VLOOKUP(B8,$G$2:SH$6.2. TRUE)*BS ~ Y:48T,oor  #FAsee (il gme | g

=VLOOKUP(B9.$G$2:SH$6.2. TRUE)*B9 YAV Fre  Vodfpee slia) | o
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